
1.	 1

RELEASE NOTES 

MAKING 
COMPLEX 
EASY 

VERSION: 7.2.0



We have deep expertise in things that 
matter and we are easy to work with.  

Our clients trust us and we are  
respected for our creative thinking.

Together we build strong relationships by 
repeatedly delivering on our promise.

MAKING COMPLEX EASY



Prepared by:

RPS Ocean Science

55 Village Square Drive
South Kingstown RI 02879, USA

T     +1 401 789 6224
E     MapSupport@rpsgroup.com

RPS PROMISES 
ABSOLUTE DELIVERY:



OILMAP V7.2. RELEASE NOTES 2021 

OILMAP V7.2. RELEASE NOTES  |  JULY 2021 

rpsgroup.com Page ii 

Contents 

1 INTRODUCTION ...................................................................................................................................... 1 

1.1 Operating System Compatibility .................................................................................................... 1 

1.2 OILMAP v7.2 Modules ................................................................................................................... 1 

2 OILMAP V7.2 USER INTERFACE UPDATES ........................................................................................ 2 

2.1 Resolved Interface Bugs ................................................................................................................ 2 

2.2 Subsurface (3D) & OILMAPDeep Module Improvements ............................................................. 4 

2.3 Updates to Viewing Model Results ................................................................................................ 5 

2.3.1 Viewing Deterministic Output ........................................................................................... 5 

2.3.2 Viewing Stochastic Output ............................................................................................... 8 

2.3.3 SHP File Export ................................................................................................................ 9 

3 OILMAP V7.2 MODEL UPDATES ........................................................................................................ 12 

3.1 Resolved Model Bugs .................................................................................................................. 12 

3.2 Model Computational Improvements ........................................................................................... 12 

3.3 New and Improved Model Algorithms .......................................................................................... 12 

3.4 Updates to the Stochastic Module ............................................................................................... 14 

4 MODELING INPUT GUIDELINES ......................................................................................................... 15 

 

Figures 

Figure 1. Water Column Concentrations time series breaks when changing X-axis. ........................................ 2 

Figure 2. Overflow error when opening concentration graphs. .......................................................................... 2 

Figure 3. Corrected Thickness label. ................................................................................................................. 3 

Figure 4. Removal region start and end time ..................................................................................................... 3 

Figure 5. Updates to Subsurface Paramters form (applicable only with purchase of OILMAPDeep 

Module). ......................................................................................................................................... 4 

Figure 6. Oil spill model mass balance graph. ................................................................................................... 7 

Figure 7. Interrogating oil in ice particles. .......................................................................................................... 7 

Figure 8. Model Information form now includes water column. ......................................................................... 8 

Figure 9. Viewing stochastic results. .................................................................................................................. 8 

Figure 10. Stochastic Model Information form. .................................................................................................. 9 

Figure 11. Stochastic output. .............................................................................................................................. 9 

Figure 12. Concentration thresholds and depth vertical layers can be specified for a SHP file export. .......... 10 

Figure 13. Export results to SHP file. Attach SHP file to OILMAP and interrogate the layer to view SHP 

file information shown above. Exported SHP files may be viewed in other GIS tools. ............... 10 

Figure 14. Properties window when interrogating an Export SHP file attached as layer in OILMAP. ............. 11 

Figure 15. Choosing Currents Data as Depth Data Source. ............................................................................ 13 

Figure 16. Probability Grid Form. ..................................................................................................................... 14 

Figure 17. Stochastic Paramters Form. ........................................................................................................... 15 

Figure 18. If you do not have grid information, you will receive this error........................................................ 15 

Figure 19. Parameters Tab .............................................................................................................................. 16 

Figure 20. Stochastic Parameters form ............................................................................................................ 16 

 

file://///RI-VSQ-FS-01/Products/ASAProducts/Version%207.2%20Release/OILMAPv7.2.0_ReleaseNotes_DRAFT_Jan2021.docx%23_Toc60825541
file://///RI-VSQ-FS-01/Products/ASAProducts/Version%207.2%20Release/OILMAPv7.2.0_ReleaseNotes_DRAFT_Jan2021.docx%23_Toc60825541


OILMAP V7.2.0 RELEASE NOTES 2021 

rpsgroup.com Page 1 

1 INTRODUCTION 

The first version of OILMAP was delivered over 30 years ago and is now used globally by many international 

organizations, including major oil companies and marine pollution response agencies. It has been used 

successfully to support spill response, planning, and permitting in over 100 countries. The Deep Water Horizon 

spill in 2010 shifted the demands on oil spill models in terms of their ability to manage deep water continuous 

releases and deal with complex environmental datasets. The scientists and researchers at RPS have 

incorporated lessons learned and new technologies into OILMAP version 7.2.   

Version 7.2.0 of OILMAP includes many enhancements and added features to help improve oil spill response, 

drill exercises, impact risk assessments, and contingency planning. Enhancements were made to both the 

models and the user interface, including but not limited to, major speed enhancements to the model. This 

document describes the various new features and bug fixes included in OILMAP v7.2.0. 

 

1.1 Operating System Compatibility 

Version 7 (and newer) of the RPS MAP applications, OILMAP, SARMAP, and CHEMMAP, are supported on 

the following Microsoft Windows platforms: Windows 10, 8, 7, Windows Server 2012 and 2016, Microsoft 

Azure, and Amazon Web Services. 

 

                                                  

 

1.2 OILMAP v7.2 Modules 

Surface module Simulates the behavior of surface oil spills released on the water surface. 

Subsurface module Simulates oil releases occurring below the water surface. 

OILMAPDeep module Simulates blowouts, including seabed dispersant application. 

Backtrack module Evaluates the source of a mystery spill. 

Stochastic module Calculates the probabilistic distribution of oiling in water and on shore.  

Airmap module Calculates the atmospheric dispersion of the lighter oil fractions from a spill. 

OILMAPLand module Evaluates the transport and fate of oil released on land reaching river networks. 
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2 OILMAP V7.2 USER INTERFACE UPDATES 

2.1 Resolved Interface Bugs 

The following bugs have been reported, logged, and fixed: 

1. Overflow error when importing XYZ grid to fill depth. 

2. Water Column Concentrations time series breaks when changing X-axis. 

 

Figure 1. Water Column Concentrations time series breaks when changing X-axis. 

 

3. Fixes to Hydrocarbon graph peak concentration display: 

a. No overflow errors.  

b. Fixes to unit conversions.  

 

Figure 2. Overflow error when opening concentration graphs. 

 

4. SPT option in Subsurface Parameters form is now greyed out when not in use. 
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5. Deterministic export now starts at first time step. Previously skipped first timestep. 

6. When interrogating a surface particle -> clicking on “Concentrations” and viewing Thickness graph; 

The title is now “Thickness of Emulsified Oil”. 

 

Figure 3. Corrected Thickness label. 

 

7. Dispersant and removal region start time defaults to where the users time slider is and the end time 

defaults to the end of the simulation.  

 

Figure 4. Removal region start and end time  

 

8. Transition from sequential currents to EDS data now saves when moving to different tab.  

9. When setting turbulence to high in subsurface release: restarting OILMAP now saves this option. 

10. “Save model Currents” option now saves after users run the model. 

11. PNG file now gets created correctly, previously nothing appeared in the saved PNG. 

12. Oil additions to personal database are now saved.  
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2.2 Subsurface (3D) & OILMAPDeep Module Improvements  

There have been both user interface and model (see Section 3) updates to the OILMAPDeep blowout 
module:  

1. Additions to the form include: 

a) Gas viscosity,  

b) Droplet/Bubble distribution lognormal standard deviation, and 

c) The ability to turn off randomization of droplet sizes. 

2. Additions a) & b) have an option that toggles between default (RPS assigned value based on most 

up to date scientific expertise) and the user-defined value. 

3. There is now an option to read in pre-existing SPT’s in the subsurface parameters form 

a) Reads from the RUNDATA folder of users Loc_data for available “.SPT” files.  

4. Running with Uncertainty Particles is now an option for Subsurface releases.  

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5. Updates to Subsurface Paramters form (applicable only with purchase of OILMAPDeep Module). 
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2.3 Updates to Viewing Model Results  

2.3.1 Polygon Release Updates 

OILMAP has been updated to include the ability to start a scenario using a user-drawn or SHP file polygon.  

 

Select File → New Scenario. This will open the newly created oil 
spill location form that allows the user to define how the scenario 
location will be selected. The user can now continue to draw a 
manual polygon release as was previously available but OILMAP can 
also use a SHP file to initialize a scenario. 

 

This enables user to input a potential spill as a polygon SHP file. This 
is often the format that satellite detections and spill observations are 
presented using. The user can now easily start a scanrio from the 
SHP file and view the trajectory out. 

 

When ‘Select SHP file for polygon release’ is chosen the windows explorer window will open and the user 
can navigate to the desired SHP file. Once the SHP file is selected the GIS file will be added to the layer list 
so the user can see the data. The New Oilmap Scenario form opens and shows the number of polygons in 
the chosen file and allows the user to define the Scenario name. 

 

 

 

The user Clicks OK and is presented with the Polygon Release 
Parameters form to define the release information for the SHP file.  
There are 3 options that the user can select to initialize the oil spill.  

• Calculated Area 

• User defined % 

• User Defined Thickness 

The user can input the chosen option 
for each input type to initialize the 
polygon types. The user can click ok 
and move to scenario inputs. The user 
can also skip this step and click apply 
and access the Polygon Release 
Parameters from the Run Form. 

For User Defined Thickness the user can defined thickness definition as per the table below: 
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Bonn Agreement approx. thickness (in mm, see User Manual) 

Silver Sheen:  0.0001 

Rainbow Sheen:  0.001 

Metallic Sheen:  0.025 

Transitional Dark Color:  0.1 

Dark (true) Color:  0.5 

Emulsified: 0.5 

 

The spill form user inputs remain the same for all 
polygon release. The user must enter the Oil Spill 
Amount for Calculated Area and User defined % 
but the spill amount will be calculated based on oil 
type and chosen thicknesses for User Defined 
Thickness. Spill Duration will always be set to 0 
as an instantaneous spill to represent the polygon 
oil slick transport. 

 

 

 

 

 

The particles fill the area defined by the SHP polygons and transport the oil based on the user inputs.  
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2.3.2 Viewing Deterministic Output 

1. Fates section of mass balance graph now has title “Mass Balance for *Name of Scenario*” 

 

Figure 6. Oil spill model mass balance graph.  

 

2. Microsoft PowerPoint created by OILMAP now includes time zone information.  

3. Users can now interrogate particles trapped in ice: Defined as: “Oil in Ice” Particle type. 

 

Figure 7. Interrogating oil in ice particles. 

 

4. Previously, the polygon tool in the oil weathering information window polygon tool only included 

shoreline and surface oil. Now, there is the ability to show entrained water column oil in this polygon 

as well. Users are now able to draw a polygon around results and get the water column mass. 
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Figure 8. Model Information form now includes water column. 

 

5. In Oil database: surface tension is now oil-seawater interfacial tension. 

2.3.3 Viewing Stochastic Output 

1. New workflow for viewing stochastic results: 
a) "View Stochastic Analysis Parameters" is under the Model Output Menu, 

b) "Stochastic Weathering Summary", "Shoreline Oiling Summary",  and "Individual Tracklines" 

under "Stochastic Options" sub-menu 

 

 

Figure 9. Viewing stochastic results. 

 

2. OILMAP now displays stochastic NC output. 

3. Added more options in the Stochastic dropdown menu for viewing output: 

a) When "All Runs" and "Shore" are selected, the second drop down menu shows "Volume" under 

the "Thickness" option; 

b) When an individual run is selected, and shoreline oil is selected, the second drop down menu 

has an option for "Maximum Volume"; 
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c) Maximum volume will show the volume of oil in m3 for each gridded shoreline cell. 

 

 

Figure 10. Stochastic Model Information form. 

 

 

Figure 11. Stochastic output. 

 

2.3.4 SHP File Export 

The OILMAP Stochastic SHP File Export has been updated. To export model results as a SHP file, go to 

Model Output  Export Results to SHP or KML File.  

1. The new stochastic model now generates water column concentrations by depth layer. Users can 
now export SHP files by specific vertical layer, a set of layers, or all.  

2. A list of concentration or thickness thresholds are displayed as values – mm for surface and land, 
ppb for subsurface – and thresholds can be specified to export.  

3. For a stochastic case, the SHP file export now includes maximum thickness for surface, subsurface, 
and shoreline oil (labeled as ‘maximum’). 
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4. Now able to export the new mass on shore stochastic result to a SHP. 

5. The default location for the SHP file export is the SHAPE folder in the Loc_data. This destination 

folder may be changed in the Export File Name field by clicking on the Browse button. Depending on 

the length of the simulation and the number of steps being exported, the SHP files may be very large 

in size. 

 

Figure 12. Concentration thresholds and depth vertical layers can be specified for a SHP file export. 

6. The variables names and corresponding units in the Deterministic SHP file export are as follows: 
a) DATETIME = Date and time of particle 
b) HRS_IN_SPL= Hours into Spill  
c) LONGITUDE= Longitude 
d) LATITUDE= Latitude 
e) MASS_MT= Mass of particle, Metric Tonnes 
f) THICK_MM= Thickness of particle, Millimeters 
g) VISC_CP= Viscosity, Centipoise 
h) WTRCNT_PCT= Water Content, Percent 
i) STATUS= Identifies particle as Surface, Subsurface, or Uncertainty particle.  

i. 0= Surface, 2 = Subsurface, 3= Uncertainty 
j) DEPTH_M= Depth of particle, Meters 

 

 

Figure 13. Export results to SHP file. Attach SHP file to OILMAP and interrogate the layer to view SHP 
file information shown above. Exported SHP files may be viewed in other GIS tools. 
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7. Shoreline data is now exported as a separate line segment. No longer as part of the spillet data.  

8. For subsurface concentrations, the SHP file includes the total hydrocarbon concentrations by vertical 
layer as well as the vertical maximum concentration. 

 

Figure 14. Properties window when interrogating an Export SHP file attached as layer in OILMAP. 
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3 OILMAP V7.2 MODEL UPDATES 

3.1 Resolved Model Bugs 

1. Don't allow spillets to jump the boom when they can't be beached and are put back in the water.  
2. Updates to the Reanalysis of Stochastic models. 

3. Model fix regarding vertical entrainment at low wind speeds (1.5 m/s to 4 m/s) to ensure minimum of 

oil becoming entrained. 

3.2 Model Computational Improvements  

1. The model now loads the data of the wind file into memory instead of accessing the disk, which 

greatly increases model run time.  

2. Improvements to our hydrodynamic algorithms improves performance for cases with NCELL type 

NetCDF files.  

3. Changed how wind/hydrodynamic NetCDF files are processed: 

b) Now read into memory the entire grid at each timestep, 

c) Added a KDTREE when processing a varierty of winds and currents NetCDF file to allow the 

model faster processing time. 

4. Speed improvements for Stochastic analysis: 

a) Leveraging multi-core machines: Model now Starts each individual deterministic run on a 

separate core, processing separate output from the deterministic model (.H5 file). 

b) Updated output writing process to generate Stochastic results faster.  

c) Added error detection to asaStoch/ Added new variable to netCDF that identifies the 

deterministic runs that were included in the analysis:  

i) When individual cases have crashed, the stochastic model can now skip over the missing 

deterministic outputs and still complete the analysis. 

ii) Furthermore, the NC file now lists how many runs were used for the analysis. E.g., if 5 out of 

100 runs crashed, the NC file says that 95 runs were used. 

3.3 New and Improved Model Algorithms  

1. OILMAPDeep Model Updates (see Section 2.2 for associated Interface updates): 

a) The OILMAPDeep model was updated to incorporate the droplet algorithm per Li et al 2017. 

This included new algorithm for defining d50 and use of a lognormal distribution.  

b) The new algorithm now requires viscosity. Since bubbles uses the same algorithm as droplets, 

gas viscosity as input was added as well.  

c) Additionally, changes to the DOR vs IFT relationships (new default based on Venkatamaran 

2011) and also now have the ability to override with user defined IFT (outside the oil database).  

d) Added an option to *not randomize droplets* as was done by default historically in subsurface.  

2. Simulate flooding/dry conditions when using a .CIR currents file: 

a) Although the flooding and drying capability has been in our tools for some time, it has only been 

available for very specific current files (.GVRs, and limited NetCDF). Now we can access this 
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capability with .CIRs, assuming the file includes information on water surface changes (tidal 

elevation), 

b) When selecting a .CIR, you now have the option to turn on Wet/Dry in the Options tab and select 

whether you want the oil to refloat,  

c) Stranded oil shows up in the legend, mass balance graph, pie chart, and listings, 

d) Oil can remain stranded or refloat, 

e) The .CIR is created with an elevation file (.CIE) and a bathymetry file (.HGR). All three files must 

have the same name and be placed in the CURRENTS folder of your geographic location, and 

f) You can display the .HGR bathymetry data that matches your .CIR by selecting to display the 

Currents Grid Depths in the ToC.  

g) In model run form, user must select bathy option as “Currents Data” 

 

Figure 15. Choosing Currents Data as Depth Data Source. 

 

h) The elevation is written to the W&C file. The elevations are calculated from the CIR/CIE/HGR 

combo at each time step and written to the W&C file for the location specified at the top fo the 

W&C file. 

3. Model now allows for dispersion in landfast ice for river cases. 

4. When using dispersants there is now a new column in the Dispersant Results file (.DSG) to indicate 

when dispersion is limited by spillet mass. Dispersant can only act on one whole oil spillet, so if the 

amount (mass) to be dispersed is less than a single spillet, that spillet will not be dispersed. This 

situation is flagged in the “limited by spillet mass” column. This Dispersant Results file can be found 

in the following menu: Model Output  Response Results Dispersant Results. 

5. When using the Boom response option:  

a) The model now generates a Boom Results file that provides users with feedback about the 

efficiency of each boom segment. This file is called ScenarioName.BEL and is located in the 

MODELOUT folder. The .BEL file reports whether the boom was limited by currents, waves or 

the retention threshold per each boom at each timestep the boom is active.  
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3.4 Updates to the Stochastic Module 

1. Gaussian spreading requires a minimum of 5 vertical layers in the Probability Grid form. 

2. Additional Info Buttons (Green and white) in Probability Grid Form. 

3. To reach the Probability Grid Form go to the Spill Form → Options → Output Display Options. 

a. Model cannot run without Probability Grid information. Enter values for the Probability Grid in the 

Options Tab to continue, 

b. Fixed number of cells in the vertical must be from 1-20, 

c. Fixed Cell Size now has a second entry for "Vertical Cell Size (Meters)". To use fixed cell size, 

user must enter both vertical and horizontal cell size, and 

d. Depth Range with minimum and maximum (meters) must be entered to run model. 

 

Figure 16. Probability Grid Form.  
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Figure 17. Stochastic Paramters Form.  

 

Figure 18. If you do not have grid information, you will receive this error. 

 

4 MODELING INPUT GUIDELINES 

1. Time step guidelines: no more than 30 minutes for offshore and coastal releases, less for rivers and 

harbors. Hourly time steps are not recommended, as results can be misleading. 

2. Due to the improvements of OILMAP’s model, it is recommended that users enter a large enough 

amount of Lagrangian particles (in the Parameters Tab). Number of particles should be on the order 

of 1,000 and more (compared to previous versions of OILMAP). Less than 1,000 particles should not 

be used.  

3. Stochastic: must include water depths and probability grid inputs.  

4. Stochastic: Turn off all water column thresholds to skip calculations of water column probabilities. 

Keep in mind you can run the initial case coarsely and reanalyze at a higher resolution.   
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Figure 19. Parameters Tab 

 

Figure 20. Stochastic Parameters form 
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